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About this manual 

This version of the manual can be used as a guide for many other proceeding and proceeding 
versions of Kayako LiveResponse Client Application. However, please note that feature discrepancies 
may exist between versions. 
 
We publish a new and up to date manual upon the release of each stable build. For accuracy, be sure 
to use the manual(s) bundled with your downloaded SupportSuite package. 
 
If you would like to send in a suggestion or report any errors in this manual, please send an e-mail to 
docs@kayako.com or post in the documentation forum - your input is very much appreciated. Please 
do not use this address for support. 
 
You can obtain further support for any of Kayako’s products via: 
 

• Support desk – www.kayako.com/support 
 

• Community forums – http://forums.kayako.com 
 

mailto:docs@kayako.com
http://www.kayako.com/support
http://forums.kayako.com/
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Introduction to Kayako LiveResponse Client Application 

Kayako LiveResponse Client Application is an application for Windows® (Microsoft® Corporation) that 
communicates with your installation of SupportSuite or LiveResponse; monitoring for user activity, 
chat requests and also provides a seamless interface to your support desk. 
 
The Client Application can be configured to alert you in a variety of ways, including:  
 

• Alerting you of new chat requests. 
• Alerting you of new visitors to your site, or areas of your site. 

 
If Kayako InstaAlert is installed, InstaAlert can be configured that when clicking on ticket 
notifications, the ticket is opened within the Client Application interface rather than in a web 
browser window. 
 
The Client Application is not licensed per machine, one purchasing a SupportSuite or LiveResponse 
license, you are free to download unlimited copies of the application and distribute them to your 
support desk staff users. 
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Client Application feature list 

 
 
Above: Kayako LiveResponse Client Application – showing two visitors browsing areas of your support 
desk installation. 
 

• Users use their SupportSuite or LiveResponse login information with the Client Application. 
o Users can only handle and respond to chat requests made to the department they are 

assigned, unless a chat is transferred to an individual. 
 

• Chat live with your website visitors. 
 

• Conference chat with a website visitor – more than one staff user may participate in a chat 
with a visitor. 
 

• Accurate, on-the-fly spell checking of your messages. 
 

• Application can be minimized and controlled via the system tray. 
 

• Notification methods can be customized using: 
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o Animated icons. 
o Pop-up notifications. 
o Sounds. 
o Staff status changes. 

• To alert you to a chat request or a new visitor. 
 

• Proactive and forced chatting options allow you to proactively communicate with website 
visitors. 
 

• Manage notes and chat histories for site visitors. 
 

• View a visitor’s foot prints and where they were referred from in real time. 
 

• Log in to your support desk seamlessly, and manage tickets and all SupportSuite or 
LiveResponse related functions seamlessly, from within the Client application. 
 

• Staff users can have an online, offline, away, busy or be back shortly status. 
 

• Use ViewShare functionality to demonstrate to your visitors from your own desktop, all 
through the visitor’s web browser. 
 

• Use hot-keys to quickly control your support desk operations and manage multiple chat 
sessions at any one time. 
 

• Canned messages (predefined responses) to speed up communication, resolution and closure 
of an issue with your visitors. 
 

• Supports multiple languages. 
 

• Ability to connect via a network proxy. 
 

• Automatic program start and login options available. 
 

• Visitor tracking across your support desk or any other of your web pages that have been 
tagged with a visitor tracking JavaScript snippet. 
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Downloading the Client Application 
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Locating the setup files 

This Client Application setup files can be found in the archive of eSupport or SupportSuite that is 
available for download from the member’s area (http://members.kayako.net), as shown below. 
 

 
 
The Client Application setup files will be found in the folder \livesupport\ of the .tar.gz archive, as 
shown below. 
 

 
 
 

http://members.kayako.net/
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Getting the latest version 

The latest stable version of the Client Application can be downloaded from http://hotfix.kayako.net. It 
is recommended you download a copy from this location, so that you can be sure you have the most 
up-to-date release. 
 

http://hotfix.kayako.net/
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Interface quick reference 

The interface quick-reference is a visual FAQ (frequently asked question) guide to the most common 
interfaces of the LiveResponse Client Application. 
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Main interface 
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Chat window 
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Installation guide 
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Step one 

After downloading the latest version of the Client Application software, run Setup.exe. This will begin 
the installation procedure, as shown below. 
 

 
 
Click on the Next button to continue. 
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Step two: License agreement 

 
 
Review the license agreement and accept the terms as appropriate.  
 
Click on the Next button to continue. 
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Step three: Component selection 

 
 
Configure the installation options as appropriate. 
 

• Program Files – this option is required for the installation of the Client Application. The 
Program Files consist of the core files needed for InstaAlert to function. 
 

• Start Menu Shortcuts – this is optional. Enabling this option will install a shortcut to the 
Client Application program in the Start Menu. 

 
Click on the Next button to continue. 
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Step four: Installation location 

 
 

• Destination Folder – the location within the file system where the Client Application program 
files are to be installed.  

 
It is recommended you leave the Destination Folder setting as what is given as default – normally 
within the ‘Program Files’ folder. 
 
Click on the Install to proceed with the installation. The Client Application program files will now be 
installed onto the system and configured. This process is automatic, and you will see window activity 
as shown below. 
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Step five: Completion 

After the automatic installation procedure has taken place, you will be presented with the following 
finishing screen. 
 

 
 
The installation is now complete. Leaving the Run LiveResponse box ticked will launch the Client 
Application immediately after you have pressed the Finish button. 
 
Click on the Finish button to finishing the installation and close this window. 
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First-time configuration guide 

The first-time configuration process is a procedure that you are taken through following the first run 
of the Client Application. The wizard will take you through the basic configurations required to get the 
application up and running. 
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Step one: Copyright notice 

 
 
Review the copyright notice and click on the Next button to continue. 
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Step two: Account settings 

 
 
To connect the Client Application to your SupportSuite or LiveResponse installation, you must enter 
its location and your staff user account information. 
 
Click on the Add button to add a new account using the window shown below. 
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• Account Name – reference name for this account. 
 

• LiveResponse URL – the URL of your SupportSuite or LiveResponse installation. 
 

• User Name – your staff user account username. 
 

• Password – your staff user account password. 
 

• Repeat Password – confirm your entry. 
 

• Make this the default account – if enabled, this account will become the default account, 
which will be logged into automatically when starting LiveResponse (if configured later). 

 
Click on the OK button to add the account. 
 
The Client Application can store the account details of more than one SupportSuite or LiveResponse 
installation. If you wish to add more account details, enter them now. If not, click on the Next button 
to continue. 
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Step three: General settings 

 
 
Filter Options 
 

• Visitors – if enabled, visitors to your site (or any of your web pages that you have added a 
visitor tracking button or live chat button to) will be listed in the monitor pane. 
 

• Pending Chats – if enabled, visitors who are requesting a chat session will be listed in the 
monitor pane. 
 

• Active Chats - if enabled, visitors who currently in a chat session with a staff will be listed in 
the monitor pane. 

 
Other 
 

• Enable ViewShare – if enabled, the ViewShare functionality of the Client Application will be 
activated. For more information on ViewShare, see ViewShare. 
 

• Port – the port to which visitors will connect to view your ViewShare session. 
 
Click on the Next button to continue. 
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Step four: Language 

 
 
Which language pack the Client Application will use is configured here.  
 
By default, the only language pack for the application bundled with the installation files is the default 
English (U.S.) language file. 
 
Click on the Finish button to complete the configuration and start using the Client Application. 
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Logging into the server 

To log in to an account: 
 

1. Open on the File menu. 
 

2. Hover over the Login menu. 
 

3. Click on the account to which you want to log in, as shown below. 
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View panes 
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Monitor pane 

The monitor pane lists all visitors who are viewing web pages that have the visitor tracking JavaScript 
coded in. The visitor’s IP address (and username if logged in or present in a chat), browsing time, 
country and current web page are viewable here. This, along with the department and operator (if 
the visitor is in a chat session). 
 

 
 
Right-clicking a visitor in this list will open an action menu, as shown below. 
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• Proactive Chat – allows you to proactively request or force a chat with a visitor. For more 
information on proactive chat requests, see proactive chat request. 
 

• Open – allows you to open the current page the visitor is browsing, or the page the visitor 
was referred from. 
 

• View Information – view more information about the visitor (opens the Information tab on 
the visitor information tabs bar. 
 

• View Footprints – view the footprints left by the visitor’s browsing of your web pages 
(browsing history). 
 

• View Notes – view notes attached to this visitor’s IP address, left by other staff users. 
 

• View History – view the chat history for this visitor’s account or IP address. 
 

• Add Note – allows you to attach a note to this visitor’s IP address. 
 

• Ban – ban the user (by IP address). If banned, the visitor’s chat requests will not be 
processed and the visitor will not appear on the monitor pane list. The visitor will also not be 
able to see any live support status images for your support desk installation. For more 
information on banning a visitor, see visitor banning. 

 
The Client Application polls the server for new visitor data every 15 seconds by default (this value is 
configurable under general options). You can manually force a data refresh be pressing the F5 key, or 
by clicking on the View menu, followed by Refresh Visitor Data. 
 
 

Visitor information tabs 

The location of the visitor information tabs is shown below. 
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Information 

 
 
The information tab gives a comprehensive overview of information about the selected visitor.  
 

• IP Address – the IP address of the visitor. 
 

• Host Name – the resolved IP address of the visitor. 
 

• Current Page – the page the visitor was last logged as browsing. 
 

• Page Title – the title of the page the visitor was logged as browsing. 
 

• Referrer – what page the user was referred from. If blank, either the visitor’s referrer could 
not be logged or the user came directly to this page. 
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• Total Pages – the total number of pages the visitor has been logged browsing. 
 

• Browser Type / Browser Version / Full App Version – information about the visitor’s web 
browser. 
 

• Operating System – what operating system the visitor is running. 
 

• Color Depth – the color depth the visitor is using. 
 

• Resolution – the screen resolution the visitor is using. 
 

• Country – the approximated geographical location of the visitor, based on the IP address. 
 

• Search Engine – the name of the search engine if visitor was referred from a search engine. 
 

• Search Query – if the data can be found, what keywords the visitor typed into the search 
engine to find your web site. 

 



  [ 35 ] 
 
 
 

 

 
 
 

 
 

Copyright © 2001 – 2007 Kayako Infotech Ltd. www.kayako.com 

 

 

History 

 
 
The history tab is shown above. It lists all chat histories associated with this visitor’s user account (if 
registered and logged in) or their IP address. 
 
To view a chat history, click on the respective Chat ID. It will open up the chat history for that 
session, as shown below. 
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Chat status 

 
 
The chat status tab shows either the most recent chat session with the visitor or a live feed of a chat 
in progress (refreshable by clicking on the Refresh link at the bottom of the chat feed). 
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Notes 

 
 
Visitor notes can be added from within the monitor pane or from within a chat session window. 
When a note is attached to a visitor, the note is stored according to that visitor’s IP address. This 
means that, should the same visitor return to your support desk with a different IP address, you will 
not be able to view the notes for this user left according to their previous IP address. 
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Footprints 

 
 
A visitor’s footprints are left when browsing your support desk, or any of your web pages that have 
been tagged using visitor tracking JavaScript (see What is a “Tag”?). 
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Chat history 

Full documentation for the chat history database features of SupportSuite and LiveResponse are 
available in the staff control panel manual. 
 

 
 
The chat history pane (shown above) gives a browser-type interface to the SupportSuite or 
LiveResponse staff control panel. From here, you can access all staff control panel functions as well 
as the chat histories. 
 
Chat histories can be filtered by data. To filter by date, use the dynamic calendar to select a date, as 
shown below. 
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Selecting multiple chat history entries (by checking the corresponding check boxes) will open the 
mass-management menu, as shown below. Using this menu, entries can be mass-deleted.  
 
Under the Advanced Search tab, entries can be searched for by visitor name, e-mail or transcript 
contents. Under the Settings tab, the number of entries shown per page (if there are many) can be 
limited. 
 

 
 
To view a chat history, click on the chat entry name. The transcript of this chat will be shown, as 
shown below. 
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Tickets 

Full documentation for the ticket features of SupportSuite and LiveResponse are available in the 
staff control panel manual. 
 

 
 
The tickets pane (shown above) gives a browser-type interface to the SupportSuite or LiveResponse 
staff control panel. From here, you can access all staff control panel functions as well as the ticket 
features. 
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Ad tracking 

Full documentation for the ad tracking features of SupportSuite and LiveResponse are available in 
the staff control panel manual. 
 

 
 
The ad tracking pane (shown above) gives a browser-type interface to the SupportSuite or 
LiveResponse staff control panel. From here, you can access all staff control panel functions as well 
as the ad tracking and campaign tools. 
 
To edit a campaign, click on the corresponding edit  button next to the corresponding campaign, as 
shown below. 
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Selecting multiple campaigns (by checking the corresponding check boxes) will open the mass-
management menu, as shown below. Using this menu, campaigns can be mass-deleted.  
 
Under the Advanced Search tab, campaigns can be searched for by title or URL. Under the Settings 
tab, the number of campaigns shown per page (if there are many) can be limited. 
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Handling chats 

The main functionality of the Client Application exists in its staff user interface to the live chat system 
of SupportSuite and LiveResponse. 
 
Via your client interface to your SupportSuite or LiveResponse installations or by a website that 
features your ‘live chat’ tag (see What is a “Tag”?), visitors can initiate a chat request. The visitor will 
then asked for a name and an e-mail address.  
 
Depending on how many of your staff users are available and for what live chat department, the 
visitor may be placed in a queue for support. If configured in the administrator control panel, the 
visitor will be told how many are in the queue before him. 
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Stage one: Visitor makes a chat request 

The visitor opens the Live Support tag (see What is a “Tag”?) on your support desk or tagged web 
page, as shown below. 
 

 
 
Next, the visitor enters his or her name and e-mail address, as shown below. 
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After clicking on the Submit button, the visitor enters the support queue. The visitor is shown the 
message in the figure below every X seconds for Y tries (both of these values are configured via the 
administrator control panel). 
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Chat request accepted 

If a staff user accepts a visitor’s chat request, the acceptance is indicated on the client’s chat window 
as shown below. 
 

 
 
When you (the staff user) is typing, the client is given indication of this as shown below.  
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Chat unavailable or request rejected 

If a visitor’s chat request is not accepted before the number of tries runs out, the visitor is shown a 
message dialog, as shown below. 
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Chat may not be available for any one of the following reasons: 
 

• There are no available staff users. 
 

• The chat request was actively refused. 
 

• All staff user’s are set to busy (handling too many chats – this value is configured per Client 
Application in the Client Application options). 
 

• All staff users are set to away or be back shortly (a staff user’s status is configured per Client 
Application in the Client Application options). 
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Stage two: Staff receives chat request 

When a visitor requests a chat, the system attempts to notify each available staff user. If a staff user 
does not accept the chat request within the amount of time set under Number of Seconds after each 
Retry (administrator control panel > Live Support), the system will then attempt to notify the next 
available staff user. 
 
This is called a round-robin system. The number of “rounds” (each try) is also configured within the 
administrator control panel under Number of Chat Round Robin Retries. 
 
If no staff user accepts the chat after the number of tries is up, the user will be told that live chat is 
unavailable, and will be offered the option of leaving a message. 
 

 
 
When a request comes in, it will be marked on the monitor pane and current status bar, as shown 
below. 
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From the monitor pane you can accept the chat request by right-clicking on the requesting user, as 
shown below. 
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From here, chat requests can also be actively refused. When refused, the user will be shown a “Live 
Support is unavailable” notice, and will be given the opportunity to send a message. 
 
The system tray icon for the Client Application will flash red to indicate the pending chat request. 
The number in the middle of the icon shows the number of site visitors being monitored. 
 

 
 
If configured within the Client Application options, a notification popup will display and a notification 
sound will chime, indicating the new chat request, as shown below. 
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Clicking on this notification popup will accept the chat request and initiate the chat with the visitor, 
thus starting the chat session. If you just want to close the popup, click on the x, as indicated above. 
 

Chat interface 
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The typical chat window for a staff user using the Client Application is shown above. To send a 
message to the visitor, type a message in the input area and press the enter key. When typing a 
message, the user will be notified that you are typing. 
 
Under the options menu, a variety of extra tasks can be executed, as shown below. 
 

 
 

• Display ViewShare Monitor - see ViewShare monitor. 
 

• Play Sounds – if enabled, a sound will be played notifying you to a new message from the 
user. 
 

• Push URL – allows you to push a URL to the visitor. Pushing a URL involves forcibly opening 
up a new window within the visitor’s browser that opens the URL given here. 
 

• Push Image – allows you to push a URL of an image to the visitor, opening in the same way 
as pushing a URL. 
 

• Push Code – allows you to send formatted and line-numbered code to the visitor, as shown 
below. 
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• Add Note – attach a note to the record of this visitor’s IP address (notes entered this way are 
not their user account). 
 

• Ban Chatter – ban the visitor by their IP address. If banned, the visitor’s chat requests will 
not be processed and the visitor will not appear on the monitor pane list. The visitor will also 
not be able to see any live support status images for your support desk installation. For 
more information on banning a visitor, see visitor banning. 

 

Information tabs 

The information tabs here work exactly as there do In the monitor pane. 
 

Using canned messages 

A canned message acts as a predefined reply, also referred to as a standard reply. It is a 
copy/paste message or message template that can be used to more efficiently handle a support load.  
 
To use a canned message from the chat interface: 
 

1. Open the Canned menu, as shown below. 
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2. Navigate to the category and sub-categories as appropriate. 
 

3. Click on the canned message you wish to insert. 
 
The message will not be sent immediately – it will simply be copied to the input area where the 
message contents can be edited, as shown below. 
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For information on managing canned messages, see managing canned messages. 
 

Transferring a chat 

When in a chat session with a user, you can actively transfer the chat to another staff user. This will 
instantly open a new chat window on the staff user’s Client Application (to who you are transferring 
to). 
 
When a chat is transferred, the chat session will become a conference session. This means that both 
you and the staff user you transferred the chat to will be in the chat session with the visitor. The 
procedure is exampled below. 
 
To transfer the chat, click on the Transfer menu (as shown below) and select the staff user to who 
you want to transfer the chat. 
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A new window will open up on the desktop of the staff user to who you transferred the chat to. The 
chat window will be empty. However, the staff user receiving the transfer can review the transcript by 
clicking on the History tab, as shown below. 
 

 
 
As described earlier, when a chat is transferred it becomes a conference - you (as the transferring 
staff user) will still be present in the chat session in a conference mode, meaning both you and the 
staff user who you transferred the chat to can chat with the visitor. 
 
You can also leave the conference at any time, by closing your window or clicking on the Leave 
button. When you leave a conference, the visitor will be notified as such (as shown below). 
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Transferred chat sessions are listed under Transferred Chats on the current status side bar, as 
shown below. 
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Starting or entering a conference 

When a user is in a chat session with another staff user, you are able to start a conference session 
by right-clicking on this user within the monitor pane (as shown below) and clicking on Start 
Conference. 
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Your chat window will appear empty. You can review a transcript of the chat so far by clicking on the 
History tab, as shown below. 
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When you leave the conference (either by closing your chat window or clicking on the Leave button), 
the visitor will be notified as such, as shown below. 
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Please note that the conferencing functionality of the Client Application is not the best way to simply 
monitor a chat’s progress. If you simply want to review a live transcript of a chat, click on the 
History tab within the monitor pane. 
 

Starting a ViewShare session 

To launch a ViewShare session with a user, click on the ViewShare button as shown below. 
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You will be notified when the visitor is connected (shown above). Shown below is an example of the 
kind of feed the visitor sees. 
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When the visitor has closed his or her window of your desktop feed, you will also be notified as such, 
as shown below. 
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To end a ViewShare session from within the chat interface, click on the ViewShare button again. 
 
Note that even though a user has ended their view of your desktop feed, the connection within the 
ViewShare server may still be active. For security reasons, use the ViewShare monitor to ensure the 
connection is closed (a visitor cannot connect to your ViewShare server without an active connection 
hash. 
 

Spell checking features 

If enabled, your typed input during a chat session is automatically spell checked. Any spelling errors 
are highlighted by a red underline, as shown below. 
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To view a list of suggested corrections for a highlighted word, right-click on the word and select from 
one of the suggestions. If the spelling is correct and you want to add it to the dictionary as a correct 
term, click on the Add menu option. 
 
Spell checker options and dictionaries are configured and selected in the Client Application options 
area. 
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Making a proactive chat request 

When a user is browsing your support desk and tagged web pages (see What is a “Tag”?), it is 
possible for a staff user to proactively make a chat request to that user. 
 
A chat request can be forced or requested.  
 
A forced chat request will instantly open a chat window and chat session for that visitor and for you 
(the requesting staff user). A requested chat session involves a dialog appearing on the visitor’s web 
browser asking whether or not they would like to start a session, as shown below. 
 

 
 
If a chat request is forced and the visitor is using a popup blocker, the forced chat request may not 
open and the visitor may not notice the request has been made.  
 
However, if the chat request is requested (as shown above), a popup blocker will not block the 
popup as the request window is not made in a popup, but in a new layer on the web page. 
 
Chat requests can be made from within the monitor pane, as shown below. 
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If the request has been processed successfully, you will receive the following notification. 
 

 
 
If the visitor rejects your chat request, you will not be directly notified of this. If the visitor accepts 
the chat request, the chat session will begin automatically. 
 
Note that once a chat request has made, the site visitor has to reload their page or browse to another 
page that has been tagged in order for the notice to display (see What is a “Tag”?). 
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Staff-to-Staff chatting 

Using the Client Application chat interfaces, staff-to-staff chats can take place. Using the side-bar, 
right click on a staff user can click on Start Chat, as shown below. 
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Canned messages 

A canned message acts as a predefined reply, also referred to as a standard reply. It is a 
copy/paste message or message template that can be used to more efficiently handle a support load.  
 
To view and manage canned message responses, click on the canned button on the menu bar, as 
shown below. 
 

 
 
Within the application, an interface to your SupportSuite or LiveResponse installation will be opened, 
from which you can manage the canned message responses and categories. 
 
Full documentation for managing canned messages within SupportSuite and LiveResponse are 
available in the staff control panel manual. 
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New canned message categories and messages will not be populated into your Client Application until 
you log in and out of the server. 
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Using canned messages 

The procedure for using canned messages within a chat session is described in using canned 
messages. 
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Visitor messages 

A visitor message is a message that is left by a visitor who: 
 

1. Has attempted to request live chat, but no one was available. 
 

2. A had completed an ended chat session, and was offered the option of leaving a message. 
 
Messages left by a visitor are not the same as tickets – they work different and are stored in a 
different location.  
 
As shown below, the form the visitor uses to “leave a message”. 
 

 
 
Messages can be reviewed and responded to under the Live Support section of the staff control 
panel (in SupportSuite or LiveResponse). Full documentation of the visitor messages management is 
provided in the staff control panel manual.  
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ViewShare 

The ViewShare component of the Client Application allows you to broadcast a direct feed of your 
desktop to a site visitor from within a chat session. On the client end, the broadcast is entirely 
browser based and powered by JavaScript, so the visitor does not need to download anything. 
 
An example of a client’s view of a desktop feed is shown below. 
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Setting up ViewShare 

ViewShare can be configured within the Client Application options dialog (Tools > Options > Chat). 
 

 
 
ViewShare Settings 
 

• Enable ViewShare – in order to be able to use ViewShare, this box must be checked. 
 

• Port Number – the port number through which visitors will connect to your ViewShare 
process on your computer. 
 

• Image Quality – the quality of the broadcast image. The higher the quality, the higher your 
upload bandwidth should be (it is unlikely the visitor will be bottlenecked by a bandwidth too 
low). 
 

Connection Method 
 

1. Automatically determine IP address – this is best left set to default. However, if you’re your 
visitors are experiencing problems connecting, manually enter your external IP address under 
Use this IP. 
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Using ViewShare in a chat 

The procedure for using ViewShare within a chat session is described in starting a ViewShare session. 
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ViewShare monitor 

The ViewShare monitor displays all current and active ViewShare connections to your Client 
Application.  
 
To open the ViewShare monitor: 
 

1. Open the SupportSuite menu. 
 

2. Click on the ViewShare Monitor menu option. 
 

 
 
To close a connection, select the connection hash and click the Kill Hash button. The Shut Down 
button will shut down the ViewShare server for your Client Application. Without an active connection 
hash, a user cannot connect to your ViewShare server. 
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Staff statuses 

A staff user can have the following statuses: 
 

2. Online 
3. Offline 
4. Be back shortly 
5. Away 

 
A staff user can also have a status of Busy – but this status cannot be manually set, and is used 
internally only when a user is handling the maximum number of chat requests (this number is 
configured under general options).  
 
When staff are available (not busy and are all online), the live support status icon will display as 
below: 
 

 
 
When all staff users are offline: 
 

 
 
If some staff users are online but their status is accumulatively set to away: 
 

 
 
If some staff users are online but their status is accumulatively set to be back shortly: 
 

 
 
Users set to any status other than Online will not receive new chat requests. 
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Changing status 

Your status can be changed from the system tray icon or from within the application interface. 
 
To change your status from the system tray, right click on the Client Application icon and select your 
status, as shown below. 
 

 
 
To change your status from within the application, change your status using the menu shown below. 
 



  [ 84 ] 
 
 
 

 

 
 
 

 
 

Copyright © 2001 – 2007 Kayako Infotech Ltd. www.kayako.com 

 

 

 
 



  [ 85 ] 
 
 
 

 

 
 
 

 
 

Copyright © 2001 – 2007 Kayako Infotech Ltd. www.kayako.com 

 

 

Visitor banning 

A visitor can be banned by IP through the monitor pane or from directly within a chat session’s 
window. 
 
When a visitor is banned, he or she will not be able to see the live support status icon. The visitor will 
also no longer appear within the monitor pane (the visitor will no longer be tracked). 
 
Bans are enforced according to the visitor’s IP address. Therefore, if the visitor returns with a 
different IP address, he or she will be able to evade the ban. 
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Removing and managing visitor bans 

Visitor bans are managed using the administrator control panel (under the Live Support menu, 
as shown below). 
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Links toolbar 

The links bar is a bar of labeled URLs that can be opened within the Client Application. 
 
To display the links bar: 
 

1. Click on the View menu. 
 

2. Hover over Toolbars. 
 

3. Click on the Links menu option (if unchecked). 
 

 
 
The links on the links toolbar can be customized. To customize them: 
 

1. Open the Tools menu. 
 

2. Click on the Links Toolbar menu options. 
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From this window, you can add, remove and modify existing link items.  
 
Web pages loaded within the Client Application can be navigated around using the browser controls 
toolbar. 
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Browser controls 

The browser controls toolbar is a toolbar consisting of a back, forward, refresh and stop browser 
controls, as shown below. 
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Options and configuration 

All of the Client Application’s core configuration can be made within the options dialog. To access the 
options dialog: 
 

1. Open the Tools menu. 
 

2. Click on the Options menu option. 
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General 

 
 
Accounts 
 

• Add – add an account. 
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• Edit – edit an account’s existing details. 
 

• Delete – delete an account. 
 
 
General Settings 
 

• Automatically start SupportSuite with Windows – if enabled, the Client Application will 
start automatically when a user logs on to Windows. 
 

• Automatically log in on startup – automatically log the Client Application into the default 
account. 
 

• Mark me as Busy when I’m chatting with – the number of chat sessions you can have 
open before being marked as busy (see staff statuses for more information). 
 

• Mark me as Away when I’m idle for – how many minutes of mouse inactivity will pass 
before being marked as idle. 
 

• Refresh visitor data every – the time between each poll the Client Application will make to 
the server for visitor information and chat transcript updates. 
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Network 

 
 
Connection 
 

• Automatically try to reconnect to server – if enabled, the Client Application will make 
automatic connection retries if it finds itself disconnected from the server. 
 

• Reconnect attempt interval – the time (in minutes) between each retry.  
 
 
Proxy Settings 
 

• Use HTTP proxy to connect to the server – if checked, the Client Application will use the 
proxy settings (configured below this field) to make a network connection. If you are outside 
of a large business network, it is recommended to leave this setting disabled. 
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Display 

 
 
Display 
 

• Shortcut Pane – if checked, the shortcut pane display will be enabled (the pane is shown 
below). 
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• Staff status - – if checked, the staff status display will be enabled (the display is shown 
below). 

 

 
 

• Auto-Hide SupportSuite on Startup – if enabled, the Client Application will automatically 
minimize to the system tray. 
 

• Theme – select how the Client Application should be themed.  
 

• Data Columns – select the data columns you wish to view in the monitor pane. 
 

• Automatically hide shortcut bar in browser mode – if enabled, when browsing a web 
page within the Client Application, the shortcut bar will be hidden – giving you a full browser 
view. 
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Alerts 

 
 
Standard Alert Settings 
 

• Change Standard Alert Settings – this dialog allows you to change what events trigger alert 
notifications, and what sound (if any) should be played. 
 

 
Alert Time To Live 
 

• Show Alert Popups for – how long (in seconds) the popup notifications should display. 
 

• Repeat alerts – if enabled, the alerts will be repeated after the “Show Alert Popups for” 
time has expired. 
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Chat 

 
 
Chat Settings 
 

• Prompt to e-mail conversation on session end – if enabled, you will be prompted with a 
notification asking whether or not you would like to e-mail a transcript of an ended chat 
session. 
 

• Automatically maximize chat windows on popup – if enabled, the chat interface window 
will be maximized automatically. 
 

• URL encode the outgoing messages – if enabled (disabled by default), outgoing URLs will 
be encoded (such as, replacing spaces with %20, converting ampersands to &amp; and so 
on). You may want to enable this if you have issues with sending links containing spaces, that 
become “unclickable” as they have not been encoded into one string. 

 
 
ViewShare Settings 
 

• Enable ViewShare – in order to be able to use ViewShare, this box must be checked. 
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• Port Number – the port number through which visitors will connect to your ViewShare 
process on your computer. 
 

• Image Quality – the quality of the broadcast image. The higher the quality, the higher your 
upload bandwidth should be (it is unlikely the visitor will be bottlenecked by a bandwidth too 
low). 
 

Connection Method 
 

6. Automatically determine IP address – this is best left set to default. However, if you’re your 
visitors are experiencing problems connecting, manually enter your external IP address under 
Use this IP. 
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Hot keys 

 
 
Hot keys can be assigned to common commands and tasks – for example, the insertion of a canned 
message or switching panes. 
 
To set a hot key for a task:  
 

1. Select the task (as shown above).  
 

2. Slick on the text area (above, it currently says “None” indicating there has been no 
assignment for this action).  
 

3. Once the text area is selected, press the  actual key (or key combination, such as CTRL+Z) to 
which you want to assign the action. 
 

4. Click on the Set button to confirm the assignment. 
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Spell check 

 
 
Spell Checker Settings 
 

5. Enable spell checking during chat – if checked, the spell checker will be enabled. 
 

6. Ignore words with Initial Capitalization – if checked, the spell checker will not spell check 
words that have the First letter capitalized. 
 

7. Ignore words in UPPER CASE - if checked, the spell checker will not spell check words that 
are in UPPER CASE. 
 

8. Ignore words in MiXeD cAsE - if checked, the spell checker will not spell check words that 
are in MiXeD case. 
 

9. Ignore words with numbers in them - if checked, the spell checker will not spell check 
words that have numbers in them (such as numbers9 or numb3rs). 
 

 
Dictionary Settings 
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• Dictionary – select which dictionary the spell checker should use. 
 

• Path – set the path to dictionaries that the Client Application will list here. 
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Language 

 
 
Language Settings 
 

• Language – set which language pack should be used for the Client Application menus, table 
headings, window titles and so on. 
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Support resources 

If you would like to send in a suggestion or report any errors in this manual, please send an e-mail to 
docs@kayako.com or post in the documentation forum - your input is very much appreciated. Please 
do not use this address for support. 
 
You can obtain further support for any of Kayako’s products via: 
 

• Support desk – www.kayako.com/support 
 

• Community forums – http://forums.kayako.com 
 

mailto:docs@kayako.com
http://www.kayako.com/support
http://forums.kayako.com/
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Frequently asked questions 

How do I add a new language pack to Client Application? 

To install a new language pack for the Client Application (you should have already downloaded your 
Language.xml file or created your own), copy the file into the C:\Program 
Files\Kayako\LiveResponse\Lang (what was set during the installation process Step four: 
Installation location). 
 
Now configure the Client Application to use the new language pack in the language dialog. 
 

How do I write a new language pack for the Client Application? 

The words and phrases the Client Application uses are all stored in an XML file located in the \Lang\ 
folder of your the Client Application installation path (what was set during the installation process 
Step four: Installation location). 
 
To create a new language pack, create a copy of Default.xml and name it accordingly (such as 
Spanish.xml). 
 

 
 
Open up the file. You will be presented with XML markup similar to the following: 
 
 <code>Code</code> 
 <title>English (U.S.)</title> 
 <rtl>false</rtl> 
 
It is this markup that needs to be modified in order to create a new language pack. Begin by 
configuring the Code, Title and RTL properties of the XML file. 
 

• Code – should be left as “Code”. 
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• Title – the title given to your language pack (this is the title that will be displayed when 
selecting a language pack from within the Client Application as in the language dialog). 
 

• RTL – whether or not the language contained in this file is a right-to-left language and 
character set such as Hebrew. 

 
Once this basic configuration of the language file has been complete, you can now start translating 
the phrases, as described below. 
 
 <string id="IDS_MAINWNDTITLE">Kayako LiveResponse</string> 
 <string id="IDS_APPNAME">SupportSuite</string> 
 <string id="IDS_ERRMSGTITLE">SupportSuite - Error</string> 
 <string id="IDS_INFOMSGTITLE">SupportSuite - Information</string> 
 
The “id” of the phrase should not be changed. This is the ID the Client Application uses to reference 
these phrases. The only text that should be changed is highlighted in red – all other markup should 
be left alone. 
 

What does “The Client's Chat Window is not responding” mean? 

When the Client Application doesn’t receive a response from the visitor’s browser window whilst in a 
chat session, this notice will be displayed. 
 

 
 
Seeing this message more than once is usually an indication that the visitor has closed his or her chat 
window. However, seeing it once may just be the result of connection issues on the visitor’s end. 
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How are notes stored? 

Notes are stored and associated with by a visitor’s IP address. This means that if the same visitor 
returns to the support desk with a different IP address, you will not be able to retrieve notes for that 
visitor left for a pervious IP address. 
 

How can I save a copy of a chat transcript? 

To save a HTML file of the current chat transcript from within the chat interface: 
 

1. Open the File menu. 
 

2. Click on the Save As… menu option, as shown below. 
 

 
 

What is a “Tag”? 

A tag is a JavaScript tab that can be generated and placed on your web pages, and is already placed 
on the pages of your client interface to your support desk. 
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Tagging a web page enables you to track visitors through the page, using the visitor tracking features 
of LiveResponse – particularly the features within the Client Application. 
 
There are two types of JavaScript tag – one which simply and silently monitors your visitors, the 
other displays the status of your live support departments as well as monitoring your visitors, for 
example: 
 

       
 
When a visitor clicks on one of these tags, he or she will be able to start a chat request (depending 
on the status of your departments). 

Do I need to purchase licenses for the Client Application? 

No, you do not. The Client Application is not licensed per machine, one purchasing a SupportSuite or 
LiveResponse license, you are free to download unlimited copies of the application and distribute 
them to your support desk staff users. 
 

I have logged into the Client Application, but Live Support still displays as 

Offline 

 
 
The most common cause of this issue is that you have not given yourself or the staff user in question 
access permissions to the live support department(s). Permissions are managed within the 
administrator control panel of your SupportSuite or LiveResponse installation. 
 

How are chat histories recorded? 

Chat histories are stored by a visitor’s IP address, or if one is available (either by the visitor logging 
into the support desk or entering and e-mail address when requesting a chat session), stored by their 
e-mail address. 
 
When stored by e-mail address, chat histories can be called up from within the SupportSuite or 
LiveResponse staff control panel. 
 

All staff users are not notified to a chat request – why? 

When a chat request comes in, the system notifies each available staff user in turn. If the staff user 
does not respond within a given time, the next staff user will be “tried”. This system is explained in 
more detail in staff receives chat request. 
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Error messages explained 

Event logger 

The Client Application has an integrated event logging system and a log viewer. Most errors (among 
other events) are reported to this log. 
 
To view the event log: 
 

1. Click the Tools menu 
2. Click the Event Log menu choice. 

 
This will bring up a window similar to the following: 
 

 
 

Error: “The server returned an error response” 

Possible causes: 
 

1. This error is most commonly caused by a 404 Not Found error, a Forbidden error or any other 
HTTP code that is not 200 (the code for “successful”).  

 
Potential solutions: 
 

1. Check you have entered the correct path to your support desk in Options: General. 
2. Check the configuration of your web server (such as folder permissions, .htaccess permissions 

etc.).  
 

Error: “Unknown error” 

Possible causes: 
 

1. Something has gone very wrong within the internals of the Client Application. 
 
Potential solutions: 
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1. Restart the program. If the problem persists, make sure you have the latest stable build of the 

Client Application (see getting the latest version). 
 

Error: “Received unexpected response from server (invalid header)” 

Possible causes: 
 

1. The Client Application receives data it does not expect to receive. 
 

2. Your support desk may be “down” and displaying an error message (such as a MySQL error). 
 

3. Your support desk may be displaying a license error. 
 

4. Your support desk may be reporting that the setup directory still exists. 
 
Potential solutions: 
 

1. Ensure you are running the latest stable release of the Client Application (see getting the 
latest version). 
 

2. Ensure your support desk is working properly. 
 

Error: “The session has expired” 

Possible causes: 
 

1. When the Client Application logs into your support desk, it creates an active session for your 
username. If this session is deleted or ended for any reason, this error will be generated. 
 

2. A common cause of this error is that more than one copy of the Client Application is being 
used to login to the same support desk – each one attempting an alternating login that 
interferes with the other’s session. 

 
Potential solutions: 
 

1. Ensure that no more than one copy of the Client Application is being used to login to your 
support desk with the same username. 

 

Error: “Failed to connect to server” 

Possible causes: 
 

1. You have entered an invalid host name in your support desk URL. 
 

2. Your server is unavailable. 
 
Potential solutions: 
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1. Ensure that you have entered the correct support desk host name and URL in the options 
dialog. 
 

2. Check the connectivity of your server. 
 

Error: “Connection to the server timed out” 

Possible causes: 
 

1. You have entered an invalid host name in your support desk URL. 
 

2. Your server is unavailable. 
 
Potential solutions: 
 

1. Ensure that you have entered the correct support desk host name and URL in the options 
dialog. 
 

2. Check the connectivity of your server. 
 

Error: “Authentication has failed” 

Possible causes: 
 

1. You have entered the wrong username and password that the Client Application is attempting 
to use to login to the support desk. 

 
Potential solutions: 
 

1. Ensure that you have entered the correct username and password in the options dialog. 
 

Error: “HTTP request has failed” 

Possible causes: 
 

1. There was a problem in making the HTTP request to your support desk. 
 
Potential solutions: 
 

1. Restart the program. If the problem persists, restart your machine. If the problem still 
persists, please contact support. 
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